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					We’ve put together predefined templates and what you need to know to automatically customize and fix layout during the data scraping process.
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You can take the content of the source site to your own site as it is with its raw form or if you wish, you can have a fixed layout with the manual changes that you will make later. Although it is easy to make manual adjustments to put the captured contents in a fixed layout; When the number of content increases and reaches over a certain number, it increases your work load and causes you to lose time. To avoid this situation and make the process fully automated, you can take advantage of the templates that make Octolooks Scrapes one of the most advanced WordPress scraper plugins, allowing you to automatically apply the changes you want on the content to be scraped with one time only definitions in advance.  The steps you need to follow to use the template feature for the “Title”, “content”, “excerpt”, “featured image”, and “custom fields” fields are as follows.

	Activate the “Enable template” option under the field where you want to define the template.
	In the “Template” field that appears, define a value consisting of text and template tags.
	New posts will be created in a fixed layout in accordance with the defined template.


For example; You can scrape a article named “Hello, World!” on the source site with the value “[scrape_value] posted on Octolooks” on title template to your website with “Hello, World! posted on Octolooks” title. With this defined title template; The titles of the dynamic text in the source site will be combined with the static text we define and will determine the titles of the new posts.

[image: Content templates]




Template tags

The tags in “shortcode” format that contain dynamic data in the source site and the usage details of these tags are as follows, which you can use as they are within the template or by combining them with static text. To add these tags to your template, simply click on them and define the value if necessary. You can specify the position you want to add before clicking on the tag by moving the mouse cursor to that field within the template, or you can change its position with the cut and paste method after clicking.

	Value: It is the tag that contains the data on the source site matches with the XPath defined in the “Value” field. It is used in [scrape_value] format in “Title”, “excerpt”, “featured image” and “custom fields” fields.
	Date: It is the tag that contains the date and time in “YYYY-MM-DD HH: MM: SS” format. It is used in [scrape_date] format in “Title”, “content”, “excerpt”, “featured image” and “custom fields” fields.
	Custom field: It is the tag that contains the data in the custom field whose value is defined after the template and find & replace operations are applied. It is used in the format [scrape_meta name = “Enter name here”] in the fields “Title”, “content”, “excerpt”, “featured image” and “custom fields”.
	Source URL: It is the tag that contains the web address of the source site or the detail page which content is scraped from according to the selected task type. It is used in [scrape_url] format in “Title”, “content”, “excerpt”, “featured image” and “custom fields” fields.
	Title: It is the tag that contains the title of the created post. It is only used in the [scrape_title] format in the “content” field.
	Content: It is the tag that contains the data in the source site automatically detected or matches with the XPath defined in the “value” field. It is only used in [scrape_content] format in the “content” field.
	Categories: If defined; it is the tag that contains the categories of the created post with a comma between them. It is only used in [scrape_categories] format in the “content” field.
	Tags: If defined; it is the tag that contains the tags of the created post with a comma between them. It is only used in [scrape_tags] format in the “content” field.
	Featured image: If defined; it is the tag that contains the featured image of the created post. It is only used in [scrape_thumbnail] format in the “content” field.
	Gallery: If defined; it is the tag that contains the images in the content field of the created post as a gallery. It is only used in [scrape_gallery] format in the “content” field.
	Embed: If one of from the supported oEmbed services; it is the tag that translates the defined web address into embedding code. It is only used in the [embed][scrape_url][/embed] format in the “content” field.
	Calculate: It is the tag that contains the result of the mathematical operations defined inside. It is only used in the calc(Enter calculation here) format in the custom field.


Usage examples

Back linking to the source site

With the template you will define in the content field, you can link back to the source site itself or the detail pages from which the content is scraped according to the selected task type. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value by updating it to suit your needs.


            
                [scrape_content]

                <a href="[scrape_url]" target="_blank" rel="nofollow">Visit source site</a>
            
        




The new posts will consist of the content scraped with the [scrape_content] tag at top and the linking element with [scrape_url] tag to redirect to the address of source site at the bottom, in accordance with this defined template. Defining “target” attribute will open link it on a new page, “rel” definition will make sure that the link will not be followed by search engines. You can update these definitions, including the text “Visit source site”, to suit your needs.
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Automatic redirection to source site

You can redirect to the source site itself or the detail pages from which the content is scraped when you click on a link that leads from the listing pages of your site to the detail page with the template you will define in the content field, according to the selected task type. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value by updating it to suit your needs.


            
                <script type="text/javascript">

                window.location.replace("[scrape_url]");

                </script>                 
            
        




The new posts will be created in accordance with this template, directing to the address of the [scrape_url] tag when visited. The summary content (excerpt) on your site’s listing page is normally generated automatically on the data defined in the content field. However, since there will only be redirecting JavaScript code in the content area; Depending on the theme you use to display summary content on the listing page, you can match the “Excerpt” field to a data on the source site by selecting “Select from source” option or define the same data before the <!–more–> tag in the template.
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Adding parameters to links

You can add parameters when linking to the source site itself or the detail pages with the template you will define in custom fields, from which the content is scraped according to the selected task type. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the particular custom field.
	
In the “Template” field that appears, define the following value by updating the “name” and “value” variables to suit your needs.


            
                [scrape_url]?name=value
            
        




In accordance with this defined template, the new posts will be created with address of the [scrape_url] tag and the custom field consisting of the parameter value in the format “?name = value” appended to it. With the name definition you will make to the custom fields during the task creation phase, those posts can be created with compliance to your other themes and plugins or to be used within the other fields that support template.
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Combining multiple content

With the template you define in the content field, you can combine multiple content from the same page on the source site, but in different sections. The steps you need to follow to do this are as follows.

	Create custom fields named “content-1” and “content-2” that contain related content.
	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value.


            
                [scrape_meta name="content-1"]

                [scrape_meta name="content-2"]                    
            
        




In accordance with this template, new posts will be created with the content defined in the top named “content-1” and the content defined in the custom field named “content-2” bottom. You can change the names of custom fields to suit your needs and increase the number of custom fields for different sections to combine in your template. By default “Allow HTML tags” option is not activated, the content is retrieved as plain text in custom fields, in case of content combination you will possibly need HTML tags option is checked.
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Adding a gallery to content

With the template you will define in the content area, you can add images from the source site as a WordPress gallery. The steps you need to follow to do this are as follows.

	Define the section that contains the images on the source site with the visual selector in the content field.
	Activate the “Download images to media library” option below the content field.
	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field, define the following value.


            
                [scrape_content]

                [scrape_gallery]                    
            
        




New posts will be created with the content above and the gallery below. Since the gallery consists only of images defined in the content field when the “Download images to media library” option is active; if you want to pull these images from another section on the same page, except the content field, you must define the section that contains the images on the source site with the visual selector as the content field. You do not need to define the template [scrape_content] because this defined field is probably only composed of images and does not contain the text that you want to use as content in this case. You can also include the text-containing section in your content template by defining it in another custom field and using its template tag.
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Adding embed code to content

With the template you will define in the content field, you can add the web address of the source site or the web page of the detail page from which the content is scraped translated into an embed code according to the selected task type. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value.


            
                [embed][scrape_url][/embed]
            
        




The new posts will consist of the address of the [scrape_url] tag translated into an embed code in accordance with this defined template. The services and usage details that support embedding code are as stated in the corresponding article published by WordPress. If the source site is not in the list of supported services, you can add a manual “iframe” code to the content field and define the [scrape_url] tag in the “src” field.

[image: Adding embed code to content]




Adding a remote file to content

With the template you define in the content area, you can add CSS or JavaScript files directly to the content and ensure that the codes in these files are applied to the content. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value by updating it to suit your needs.


            
                [scrape_content]

                <!-- CSS Files -->

                <link type="text/css" rel="stylesheet" href="(Enter file URL here)" />

                <!-- JS Files -->

                <script type="text/javascript" src="(Enter file URL here)"></script>
            
        




New posts will consist of remote files in accordance with this defined template. You can change the defined file addresses so that they are retrieved from the source site or another address according to your needs.

[image: Adding a remote file to content]




Defining inline styles to content

With the template that you define in the content area, you can add CSS codes directly to the content as inline style and make them style changes on the content. The steps you need to follow to do this are as follows.

	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, define the following value by updating it to suit your needs.


            
                [scrape_content]

                <!-- CSS codes -->

                <style type="text/css">

                (Enter inline CSS codes here)

                </style>
            
        




New posts will be created to include CSS code in accordance with this defined template. You can get the defined codes from the source site according to your needs, or you can write them manually, which will have an effect on the scraped content.

[image: Defining inline styles to content]




Adding a WPBakery Page Builder shortcode to content

With the template you will define in the content field, you can combine the contents of the source site with the “shortcode” format tags supported by the “WPBakery Page Builder” plugin. The steps you need to follow to do this are as follows.

	Create the page layout you want to use as static by using “Backend Editor”.
	Activate the “Classic Mode” and “Text” tab and copy the codes in this field.
	Activate the “Enable template” option below the content field.
	
While the “Text” tab is active in the “Template” field that appears, update and define the following value, which consists of the codes you have copied, the template tags and plain text, according to your needs.


            
                [scrape_content]

                [vc_row][vc_column][vc_message]

                Original source: [scrape_url]

                [/vc_message][/vc_column][/vc_row]                    
            
        




The new posts will be created to display in the “Message Box”, a WPBakery Page Builder element, with the content above and the address of the [scrape_url] tag, along with the text “Original source” below in accordance with this defined template. You can do the same for shortcode tags that are supported by other themes and plugins too.

[image: Adding a WPBakery Page Builder shortcode to content]
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Making mathematical operations in template

You can do mathematical operations on the fixed or variable data that this field contains with the template that you define in the custom fields. The steps you need to follow to do this are as follows.

	Define the section that contains the numeric data in the source site with the visual selector in the custom field.
	Activate the “Enable template” option under the custom field.
	
Define the following value in the appearing “Template” field by updating it to suit your needs.


            
                calc([scrape_value] + 5)
            
        




In accordance with this defined template, the new posts will be created with the custom field containing the result of the mathematical operation with the variable data contained in the [scrape_value] tag. With the name definition you will make to the custom fields during the task creation phase, you can make them to be supported by your other themes and plugins or to be used in fields that support template. For example; You can add 5% commission to the prices of the WooCommerce products that will be created with “_price” in name field and calc ([scrape_value] * 1.05) value in the template field.

[image: Making mathematical operations in template]




It has never been easier to match the content you want to grab to the relevant fields. Meet the visual selector feature of Scrapes and XPath syntax for advanced usage.
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What is visual selector

Web scraping in its simplest definition; is the process of extracting, processing and automatically saving the received response by sending requests to the source site through various software code blocks. If this process is considered in WordPress; the corresponding content must be extracted and matched with the related fields to form a WordPress post. This process, which is very difficult and complex under normal conditions, even for a developer from the beginning to the end; considering other technical details, it requires advanced skills and knowledge. These codes, which are mostly developed to run for a specific source site, are not flexible and do not address you as an end user. This is exactly where Octolooks Scrapes and its visual selector come in.

Visual selector; is one of the main features of Octolooks Scrapes, which allows you to easily match content from the source site to the corresponding WordPress fields without any coding knowledge as a WordPress Scraper Plugin. This feature; allows you to visually select the XPath values of the source site instead of manually defining from the source site in fields such as title, content, featured image in order to perform a scraper task. Visual selector developed flexibly to work on different source sites; is an innovative feature that is produced by us first and directs the sector.

Using the visual selector

The visual selector is developed to address the end user therefore is very easy to use. Once you have selected the task type that suits your needs, the steps you need to take are as follows.

	Enter the web address of the source site from which you want to load content to the visual selector in the Source URL field. This web address is the address itself for the single scrape task type, for the serial scrape task type is the web address of the source page’s listing page.
	Click the button with the “crosshair” icon next to the corresponding field where you want to define the XPath value with the visual selector. The source site, will be loaded into the visual selector and opened in full screen, depending on the selected task type and the defined field.
	Hover your mouse over the content of the source site loaded in the visual selector and want to be matched with the relevant field and click when it is surrounded by a red frame. The XPath value of the clicked element will be defined in the relevant field and the visual selector will automatically close.


Visual selector and special cases

Although the visual selector is very easy to use, there are some tips to consider in some fields. These special cases are as follows.

Post item selection

In the case of serial scrape task type is selected, instead of selecting all of the excerpt content on the listing page in the source site, while defining the “post item”; the simplest detail page redirecting link should be selected such as the title, the content image, or “show more” type of text. After this definition, other links of the same structure on the listing page will be detected automatically.

Next page selection

In the case of serial scrape task type is selected, instead of selecting all of the next page button container on the listing page in the source site while defining “next page”; the simplest link that shows the continuation of the summary contents with the right arrow icon or “next”, “next page” text, should be selected. After this definition, other links of the same structure on the following listing pages will be automatically detected.

Content selection

In the case of “Select from source” option is selected for “Content” field instead of selecting the entire page including the header, sidebar, footer, etc. the smallest area covering the content should be selected. Unwanted content within the selected area can then be deleted or edited with the “Find and replace” feature.

Categories selection

Instead of selecting a single element when selecting category or taxonomies of other custom post types, including separators; the smallest area covering these elements should be selected. If no separator exists, the manual Xpath value must be defined to match all.

Automatically detected content

In case the source site contains some specific HTML elements which are determined as web standards, XPath values of these elements are automatically defined in the relevant fields with the word “automatically found”. You can leave these fields intact or redefine them manually with the visual selector too.

Content not visible in the visual selector

You can activate the “Disable styles” option at the top left of the visual selector when the content you want to extract is available in the page source but is not visible in the interface. Content hidden in the source site with CSS and then displayed in JavaScript will be visible in the visual selector.

Contents varying from platform to platform

In case the source site from which the content is intended to extract displays content varies depending on the platform, you can change the “user-agent” value of your web browser to a specific platform different from your current device, operating system, or web browser. After this operation you need to do before a new task creation, the requests to the source site will be made using the new agent user-agent “value” such content will be visible and selectable with the visual selector afterwards.

Defining manual xpath value

Although the visual selector has been developed to work flexibly on most source sites; in some cases you may need to manually define the XPath value for a more advanced use. The information that you can use to manually match the content you want to capture without using the visual selector is as follows.

What is XPath

In its basic definition XPath (XML Path Language); is a query language that allows you to find the elements and their properties contained in XML type documents. Since the HTML pages that make up the websites have a similar structure to the XML-type documents, the XPath syntax can be used to select the elements found on those pages. XPath selectors are very similar to CSS selectors; they don’t need an additional PHP library and are preferred in our plugin infrastructure because they perform better.

Necessary tools

The helper tools you can use to find the XPath values that need to be manually defined in the relevant fields are as follows. Shared examples and tools are Google Chrome compliance, but you can browse alternative tools that perform the same function if you’re using another browser.

	XPath Finder: It is a free Google Chrome extension that lets you see live HTML elements matching the XPath value entered on the source site. After installation, you can see the fields that correspond to the XPath value on the source site by entering the relevant XPath value in the field on the “XPath Finder” tab while the source site and “Developer Tools” (F12) is opened in your browser.
	Quick Javascript Switcher: It’s a free Google Chrome extension to work on the web browser that lets you emulate how the source site is interpreted on the server side by disabling JavaScript code developed. After installation, you can disable JavaScript code by clicking the “Quick Javascript Switcher” button in the plugins section while the source site is open in your browser.
	XPath Tester: It is a free website that allows you to see filtered HTML elements that match the entered XPath value in a separate field. You can see all the matching elements by entering the source codes in the “XML Input” “field and the corresponding XPath value in the” XPath Expression” field and clicking the “Test Xpath” button.


Basic XPath selectors

Let’s examine the basic XPath selectors starting with “//” on the sample XML data below that includes a restaurant’s breakfast menu, the foods in this menu, and the name, price, description and calorie information for these foods and test it with the XPath Tester tool.


	XML Input

	
		<breakfast_menu>

		
			<food>

				
				<name>Belgian Waffles</name>

				<price>$5.95</price>

				<description>Two of our famous waffles with plenty of real maple syrup</description>

				<calories>650</calories>

				
			</food>

			<food>

				
				<name>Strawberry Belgian Waffles</name>

				<price>$7.95</price>

				<description>Light waffles covered with strawberries and whipped cream</description>

				<calories>900</calories>

				
			</food>

			
		</breakfast_menu>
	


Node selector

You can establish a parent and child relationship by placing a “/” between the nodes and select the sub-nodes. In the sample XML data, all elements that match the definition of “price under food” is as follows.


	Expression

	
		//food/price
	



	Result

	
		<price>$5.95</price>

		<price>$7.95</price>
	


Index selector

You can choose the node in the order you want by defining a numerical value between “[]” next to the nodes and select. In the sample XML data “element matching the price under 1. food is as follows.


	Expression

	
		//food[1]/price
	



	Result

	
		<price>$5.95</price>
	


Comparison selector

You can choose nodes by defining comparison rules between “[]” signs next to the nodes with operators such as greater, smaller, equal. In the sample XML data, the element that conforms to the definition of “food with calories node value greater than 700” is as follows.


	Expression

	
		//food[calories>700]
	



	Result

	
		<food>

		
			<name>Strawberry Belgian Waffles</name>

			<price>$7.95</price>

			<description>Light waffles covered with strawberries and whipped cream</description>

			<calories>900</calories>

			
		</food>
	


Attribute selector

You can select an element in [@name=”value”] format according to the attribute and attribute value, such as “id”, “class” or “data”. Examples of attribute selectors are as follows.

	
		Select all elements whose value of the “class” attribute is “black”.

		//[@class="black"]
	
	
		Select all “a” elements with the value of “class” attribute is “black”.

		//a[@class="black"]
	
	
		Select the “div” element whose value of “id” attribute is “products”.

		//div[@id="products"]
	
	
		Select all “a” elements whose “class” attribute value is “black” under the “div” element whose “id” attribute value is “products”.

		//div[@id="products"]/a[@class="black"]
	


Containing attribute selector

In some cases, elements have attributes consisting of multiple and variable values. (E.g. class=”post post-123″). Since such an element does not have a single and constant attribute value, instead of directly selecting it according to the attribute value; You can select [contains (@name, “value”)] format according to any of the values it contains. Examples of containing attribute selectors are as follows.

	
		Select all elements with one of the values of the “class” attribute is “black”.

		//[contains(@class, "black")]
	
	
		Select all “a” elements with one of the values of the “class” attribute is “black”.

		//a[contains(@class, "black")]
	


Position selector

You can select an element in the [position ()> 1] format according to its position in other similar elements with the same properties. Examples of position selectors are as follows.

	
		Select all elements whose position is less than 2 in similar elements.

		//[position()
	
	
		Select all "span" elements with a position greater than 1 in similar elements.

		//span[position()>1]
	


Examples of manual XPath value definition

Examples of manual XPath value definition for some source sites, as guided by the tools and methods discussed in this article, are as follows. Shared examples may differ due to structural changes that may occur over time on source sites. The same methods can be applied to other source sites with similar properties too.

Defining manual "post item" value for Amazon

Post item; Since the XPath value of the first of the summary contents on the listing page on the source site, which redirects to the detail page when clicked, is the field to be defined, the steps you need to follow to find the value matching this definition are as follows. Make sure you also check "exact match" option after defining a manual XPath for post items.

	In Amazon, select the "Software" category and search for "Antivirus". You can then change the selected category and search word for this example to suit your needs later. Make a note of the web address in the browser for later use as the "Source URL".
	Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP.
	
In your browser, open the "Elements" tab under "Developer Tools" (F12) and identify the first anchor from the summary content that leads to the detail pages when clicked.

[image: Defining manual post item value for Amazon - Elements]





	Review whether the detected element has a descriptive property that can be selected with any selector to find the XPath value. For example, you can use the attribute selector and the value defined in the "class" attribute of this element.
	
Enter the attribute selector format XPath value of this element with the class attribute of //a[@class="a-link-normal a-text-normal"] format to the "XPath Finder" tab under "Developer Tools" (F12) in your browser and click "Filter" button, in order to check and see if it also finds the other elements of the same type to be followed.

[image: Defining manual post item value for Amazon - XPath Finder]





	When the entered XPath value works as desired and finds the all correct elements, check that it also works for the next listing pages to make sure it fits your needs. If appropriate, you can define this value in the "Post item" field.


Defining manual "post item" value for Brainy Quote

Post item; Since the XPath value of the first of the summary contents on the listing page on the source site, which redirects to the detail page when clicked, is the field to be defined, the steps you need to follow to find the value matching this definition are as follows. Make sure you also check "exact match" option after defining a manual XPath for post items.

	In Brainy Quote, search for "Software" keyword. You can then change the selected search word for this example to suit your needs later. Make a note of the web address in the browser for later use as the "Source URL".
	Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP.
	In your browser, open the "Elements" tab under "Developer Tools" (F12) and examine the values of the "class" attributes of the links for the first three of the summary content that, when clicked, lead to detail pages.
	
Instead of selecting these elements directly according to the attribute value because they consist of multiple and variable values such as "b-qt qt_656024 oncl_q", "b-qt qt_833454 oncl_q", "b-qt qt_776018 oncl_q" enter //a[contains (@class, "oncl_q")] XPath value, which is the translation of their common "oncl_q" value into the containing attribute selector format, in the "XPath Finder" tab under "Developer Tools" (F12) in your browser and click the "Filter" button, in order to check and see if it also finds other elements of the same type to be followed.

[image: Defining manual post item value for Brainy Quote - XPath Finder]





	When the entered XPath value works as desired and finds the correct elements, check that it also works for the next listing pages to make sure it fits your needs. If appropriate, you can define this value in the "Post item" field.


Defining manual "featured image" for Amazon

Amazon uses the JavaScript method called lazy load and define "data-old-hires" attribute to load images after the page is opened, instead of directly defining the addresses of the image to the "src" attributes of the "img" tags to increase the opening speed. The steps to find this value are as follows.

	In Amazon, open the detail page for the product named "Apple Macbook. You can change the selected product detail page for this example later to suit your needs.
	
Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP. Unlike normal images, only raw versions of these images with low resolution and unmodified tags by JavaScript will be displayed.

[image: Defining manual featured image for Amazon - Elements]





	In your browser, open the "Elements" tab under "Developer Tools" (F12) and identify the image element you want to select as the featured image. You can also do this by searching the address of the image file before disabling the JavaScript code in the page source code.
	
Since the address of the high-resolution version of the image file before disabling the JavaScript codes, is defined as 'data-old-hires' attribute of the 'img' element with value of the 'id' attribute is 'landingImage'; when converted to the attribute selector format //img[@id="landingImage"]/@data-old-hires, enter this XPath value in the" "XPath Finder tab under "Developer Tools" in your browser, and click "Filter" to check that it has found the visual element you want to select as the featured image.

[image: Defining manual featured image for Amazon - XPath Finder]





	When the entered XPath value works as desired and finds the correct elements, check that it also works for the next listing pages to make sure it fits your needs. If appropriate, you can define this value in the "Featured image" field.


Defining manual WooCommerce gallery "custom field" value for Gearbest

You can save the images in Gearbest's product detail page as a WooCommerce gallery thanks to "custom field" support, but the first image is used as the featured image on the source site, causing you to save the same image twice in your own WooCommerce gallery one for featured image, and the other for first image gallery. To prevent this situation, the steps you need to take to find the XPath value without taking the first image in the gallery are as follows.

	Open the product page "QIALINO Business Leather Phone Case for Huawei P30 Pro" on Gearbest. You can change the selected product detail page for this example later to suit your needs.
	
Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP. Since the images are loaded after opening the page using the JavaScript method called lazy load, after this process images will become invisible.
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In your browser, open the "Elements" tab under "Developer Tools" (F12) and identify the gallery container element. You can also do this by searching the address of the any related image file before disabling the JavaScript code in the page source code.
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The desired visual file is contained within the sequential "span" elements contained by the "span" element, which has the value of" id "attribute "js-goodsThumbnail". To prevent saving 2 times, it is necessary to select the element that contains the image without adding "/img" at the end by using position selector format enter //span[@id="js-goodsThumbnail"]/span[position()>1] XPath value to "XPath Finder" tab under the "Developer Tools (F12)" and click the "Filter" button to see if you can find the span elements that contain the visual elements you want to include in the gallery.
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The entered XPath value will work as desired and find the correct elements. However, the address of the "src" attributes have low resolution version of image files defined in the "span" elements found. Since the address of high-resolution versions is defined as "data-origin-src"; the attribute of the custom field that you need to create are as follows.


			Name: _product_image_gallery

			Value: //span[@id="js-goodsThumbnail"]/span[position()>1]

			Attribute: data-origin-src
		




Defining manual "tags" value for Medium

When selecting tags, categories or other post type taxonomies with separators, simply select the smallest area covering these elements with the visual selector and define the separator between them. However, on some sites such as Medium, in case there is no separator between these elements, the steps you need to follow to manually define XPath are as follows.

	Open the article detail page "What Is Artificial Intelligence (AI)?" In Medium. You can later change the article detail page selected for this example to suit your needs.
	
Open the "Elements" tab under "Developer Tools" (F12) in your browser and identify one of the" a "elements of the tags located at the bottom of the article.
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	Check whether the detected element has a descriptive property that can be selected with any selector to find the XPath value. For example, you can use the common value defined in the attribute selector and the "class" attribute of these elements.
	
Enter //a[@class="link u-baseColor--link"] XPath value, which is the translation of the value of the "class" attribute of this element into the attribute selector format, in the "XPath Finder" tab under "Developer Tools" (F12) in your browser and click the "Filter" button to see if it finds other elements of the same type.
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	When the entered XPath value works as desired and finds the correct elements, you can define it in the "Value" field.


Defining manual "tags" value for TechCrunch

Although TechCrunch has tags with separators between them, these tags were developed to display on the interface only after the page was opened using the JavaScript method called ajax; they cannot be detected on the server side with PHP and cannot be selected with the visual selector. In this case, the steps you need to follow to manually define XPath are as follows.

	Open the article detail page "Quadric.io raises $15M to build a plug-and-play supercomputer for autonomous systems"In TechCrunch. You can later change the article detail page selected for this example to suit your needs.
	Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP. The tags are loaded after opening the page using the JavaScript method called ajax, which makes them invisible.
	
In your browser, open the "Elements" tab under "Developer Tools" (F12) and identify the element that contains the tags. You can do this by searching for words like "tag" in the page source code.
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The searched tags are in "content" attribute of "meta" element with the separator "," and name attribute value is "sailthru.tags"; so you can define //meta[@name="sailthru.tags"]/@ content, which is translated to the attribute selector format, XPath value in the "Value" field as follows.


			Value: //meta[@name="sailthru.tags"]/@content

			Separator: ,
		




Defining manual iframe "custom field" for Watch Anime

Instead of retrieving the full post content of source sites that provide iframe or video embed code, such as Watch Anime, you may want to use the address of the corresponding video player and define it into a custom field. In this case, the steps you need to follow to manually define XPath are as follows.

	Open video detail page "Pokemon: Season 01 - Indigo League Episode 1" in Watch Anime. You can later change the article detail page selected for this example to suit your needs.
	Disable JavaScript code and refresh the page by clicking the "Quick Javascript Switcher" button in the extensions section to simulate how the page is rendered without JavaScript at server-side using PHP. If the iframe element is still visible after this operation, it means it is appropriate for the operation, otherwise it may not be suitable for the scraping operation.
	
In your browser, open the "Elements" tab under "Developer Tools" (F12) and identify the element that contains the video player address. You can do this by searching for words like "iframe" in the page source code.
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Since the address of the desired video player is defined in the "src" attribute of the "iframe" element under the "div" element, which "class" attribute value is "playerLock", so the properties of the custom field you need to create to get this value are as follows. You can define any other name in the "Name" field too.


			Name: videoURL

			Value: //div[@class="playerLock"]/iframe

			Attribute: src
		


	
To assign the address of the video player to an iframe of the desired size in the content field assigned to the created custom field, activate the "Enable template" feature of the "Content" field and enter the value below.


			
				<iframe src="[scrape_meta name="videoURL"]" width="320" height="280"></iframe>
			
		




You are interested in extracting content from a site and are wondering if you can accomplish this with Scrapes. With a few simple controls you can learn the answer immediately.

Scrapes; is a WordPress scraper plugin developed with PHP programming language that runs automatically on the server where your site is running after the necessary settings are made. With Scrapes, settings made using the visual selector via the web browser are processed and saved as a task to automatically run when the schedule time is come. Because this task is running completely in the background on the server, there is no need web browser to be open during the process.

Requests to perform scraping to the source site are sent directly from the server without using a web browser; JavaScript based codes found on the source site and developed to work on the web browser are discarded during the process and will not work. If some of these codes are using the Ajax method to populate the desired content, the task may not work as intended.

Although we continue to make various improvements so that they can be overcome, such situations, which are created by technical limitations, cause the content to be not grabbed from some source sites. In order to be able to create a problem-free task, some suggestions for solving the technical barriers encountered on the listing and detail pages, together with the criteria to be met by the source site, are as follows.

Listing page criteria

1) On the listing page, there should be a “Pagination” or “Next page” button that redirects to the next page. The content pages which are loading dynamic content without address change like “load more” button pressing or using infinite scrolls are partially supported.

Workarounds

	Without defining the “Next page”, you can have a limited number of up-to-date content that was recently added and listed only on the first page. The old content on the following pages will not be grabbed, but the new content will be displayed on the first page, so it will be automatically extracted when the runtime is come for the defined task.
	You can manually define the “Next page” value without using the visual selector. The next page link can be found in the page source in some cases, even though it is not visible in the button format on the page. You can find the HTML element that contains this link in the page source and define the XPath value in the “Next page” field. Displaying “Next page is found automatically.” means that you do not need to make this definition.
	You can select the “Enter URL parameter” option so that the next listing pages can be found by taking advantage of URL parameters in “?page=1” format. When the new URL parameter is added and its name, initial value and increment amount are defined; listing pages with this URL parameter will be detected automatically.
	You can manually create a single listing page that contains all the links on different listing pages and that lead to the detail page. If you send this file in HTML format to your server and define the web address to the “Source URL” field, the contents on the detail pages directed by the links will be automatically scraped.


2) On the listing page, there should be links in a given order and directed to the detail pages. Listing pages with links that are not positioned in a specific order, opening pages in a popup instead of link redirection, or loading content after page load action with JavaScript / Ajax technologies are not supported.

Workarounds

	You can activate “exact match only” feature to identify similar links. Links that are located on listing page redirects to detail pages when clicked;  they will be detected automatically if they have similar structure to the defined “Post Item” even though they are not in a fixed format and not wrapped in the same container element.
	You can define the feed address of source site to “Source URL” by selecting the task type as “Feed” instead of “Serial”. Feeds; Since it consists of the summary content in the standard format that leads to the detail page when clicked, there will be no need to define “Post Item” field for the automatic detection of other links of the same type.
	You can define the web address of the mobile version of source site to “Source URL” field. You can find out whether a site has a mobile version by adding the “m” subdomain to the base web address (https://m.facebook.com) or by visiting this site with your mobile device. Mobile sites; since they are developed using the most basic technologies to support all devices all links of the same type with the “Post Item” defined will be detected automatically.


Detail page criteria

1) The content should be loaded when the page is opened. JavaScript / Ajax technologies and post-loaded page content are not supported.

2) The detail pages that are redirected from the listing page should have the same HTML page structure and must be a valid HTML. Non-valid detail pages with different HTML page structure may not be supported.

Workarounds

	
Instead of identifying fields such as “Title” and “Featured image” in detail pages having different page structures using the visual selector, you can match them with generic HTML tags used on most websites, and select “Detect automatically” option for “Content” field. If the identified generic tags are already on the page, the contents within these tags will be automatically extracted. Some generic tags that can be defined are as follows.


			Title

			
				//title

				//h1

				//meta[@property="og:title"]/@content
			
		


			Featured image

			
				//meta[@property="og:image"]/@content
			
		


	You can activate “Disable styles” at the top left of the visual selector when the desired content is present in the page source but not visible in the interface. Content that is hidden by CSS in the source site and then displayed by JavaScript will become visible for the visual selector to locate.


Feed criteria

1) RSS and Atom feeds with non-valid XML structure may not be supported by our WordPress news aggregator plugin.

Workarounds

	To fix errors in feeds that do not have valid XML structure, you can install the Tidy PHP extension if not installed on your server. This extension will, if possible, fix the errors in the feed of the source site.


You can check whether the source site you are interested in is suitable for Scrapes by trying the Scrapes live demo or by contacting us at any time.

Single, serial or feed scraper. Which task type should be used in which case? For the right and efficient use, start by selecting the type of task that best suits your needs.

Scrapes is a WordPress scraper plugin that lets you easily pull content automatically with visual selector, without having any programming skills to your own website from such sites. Scrapes developed to meet different scraping needs from the simplest to the most advanced; consists of 3 different task type options, namely “single”, “serial” or “feed”.

Although they share some common settings, these task types are different from each other with their purpose of use. First the required fields “request options” in particular, to be filled in order to start scraping varies according to the selected task type.

Single Scraper

Single scraper task type; as it is the easiest task type to use, it is mostly used for simple and small web scraping operations. Taking a single page in the source site as a whole to your own website or pulling a small content on this site to embed it in any area on your website of your choice is the most accurate example of the use of this type of task.

Since the purpose of this type of task is to get content from only one page; filling the source URL field with the other required fields which are also common to other task types too is sufficient to create a scraper task of this type.

Source URL: The web address of the page that belongs to the source site you want to extract content into your site from being either starts with http or https. The entered web address is loaded into the visual selector and ease of use provided for configuring settings that require XPath value.

After the created scraper task runs successfully, the new content is generated on your site consists of a new post grabbed from the source site. You can use this post as is, edit it manually and publish later, or keep it up-to-date by taking advantage of the “Schedule” feature continuously.

Embed scraped content in an area on your site

Instead of pulling the entire content of the source site as a post, you might want to take a small portion into your site to embed it in an area of your choice. In this case, you can create a single scraper type task by using the visual selector to identify the content section you want to pull and you can embed the captured content in different areas of your website, such as post, page, sidebar with “Post Content Shortcodes” a third party free WordPress plugin. The steps that you must follow to perform this operation are as follows.

	Sign in to the WordPress administration panel (wp-admin).
	From the left navigation, click on “Scrapes » Add New” link.
	Select “Single” scraper as the task type.
	Fill in the Source URL field, define the content you want to take by using the visual selector in the “Content” settings field, configure the other settings, and save the task by clicking the “Save” button.
	After the task runs and completes successfully, click “Posts » All Posts” link from the left navigation and in order to close the accessibility of the post created for visitors edit them as, “Draft” for embedding purpose only. (You can skip this step if you have selected the post status option “Draft” while creating the task.)
	Install Post Content Shortcodes WordPress plugin and activate.
	In the post, page or text widget you want to see the embedded content, add the post ID in [post-content id=1] format as a short code.
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If you wish, you can combine multiple scraped contents from various sources and different scraper tasks by adding their shortcodes into one single post. You can also select the “Run frequency” settings of the scraper tasks that make these contents to be updated in “Every hour” or a bit more frequent period so that the post that has the merged content can be kept up-to-date continuously.  Some examples of the use of this method are as follows.

	Collection of different exchange rates in a single post.
	Collection of weather conditions of different locations in a single post.
	Collection of sales data of different products in a single post (Product comparison).
	Collection of price options on different sites for a particular product to be updated in a single post (Price comparison).


Serial Scraper

Serial scraper task type; has more advanced settings than other task types, and is often used for complex and comprehensive web scraping. Collecting all content in a source site with multiple pages to your own site as a WordPress auto post plugin, is one of the most accurate examples of the use of this task type.

Resource sites which consist of multiple pages; have a list of “pagination” pages that provide navigation between pages and excerpts that leads to the detail page when clicked. The links in these listing pages, which can be of different types, such as category, search result, gallery or sitemap, are automatically followed; filling the “Source URL”, “Post Item” and “Next Page Item” fields along with the other common required fields of other types of tasks is enough to create a this type of scraper task.

Source URL: It is the field that needs to be entered with the web address of source site’s listing pages that you want to copy content to your site from starting with “http” or “https”. This entered web address is loaded into the visual selector and ease of use is provided for configuring the settings that require XPath value.

Post Item: The XPath value that belongs to the first summary content in the listing page of the source site that also has a link to the detail page when clicked is the field that needs to be defined. In the listing page, links of the same type with this value are automatically detected. If the links to the other summary contents are not in the same container in a similar format, the “exact match only” feature is activated to identify similar links on the listing page.
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Next Page: This field can be defined in two different options, either “Select from source “or “Enter URL parameter”. “Select from source”; is the required field where the XPath value of the last link of navigation in the source page in the “pagination” format should be defined, when clicked it also leads to the next listing page to indicate the continuation of the summary of the contents in the source site.

[image: Next Page]




If this link to be defined is not available on the source page, in order to find the next listing pages by using url parameters in ?page=1 format, after “Enter URL parameter” option is selected the new URL parameter is added and the name, initial value and the increment amount are defined. More than one parameter can be added if needed. There is no need to define “Next Page” field if the desired content is available on a one single listing page.

After the created scraper task runs successfully, the content on your site consists of posts pulled from the source site. You can use these posts as they are, edit and publish them manually, or keep up to date by taking advantage of “Schedule” feature.

Feed Scraper (WP RSS Aggregator)

Feed scraper task type; is mainly used for scraping operations on feeds in “RSS” or “Atom” format, which is provided by news sites, blogs and podcasts to sync with the most current content. Grabbing all content in the source feed into different posts on your own site is one of the most accurate examples of the use of this task type. In addition, where the source site is not suitable for the serial scraper task type, the feed scraper task type is used as an alternative. This task type is also known as WP RSS Aggregator.

Feeds; because they consist of a limited number of brief contents that can be automatically detected without the “Post Item” definition and which do not require “Next Page” definition by redirecting to the detail page when clicked; filling the “Source URL” field with the required fields common to other task types is enough to create a this type of scraper task. The “Detect from feed” option in “Title”, “Content”, “Featured Image”and “Date” fields takes the summary content in the source feed into the corresponding area as well as; “Select from source” option is selected to extract the contents of the detailed pages they are referring to by defining XPath values in the relevant field instead of these summary contents.
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Source URL: The web address that starts with “http” or “https” of the source feed you want to gather content to your own site is the field that needs to be entered. This entered web address is loaded into the visual selector and when “Select from source” option is selected ease of use is provided for configuring the settings that require XPath value.

After you create and run the scraper task successfully, the posts are published with the content from the source feed. You can use these posts as they are, edit and publish them manually, or keep up to date by taking advantage of “Schedule” feature.

Finding the feed URL

To fill in “Source URL” field; some of the methods that can be used to find the web address of the source feed you want to populate content are as follows.

	The source site is controlled to see whether the standard mostly orange color feed icon is on the page. If this icon is available on the page, the web address it is redirected to is used as the feed URL.
	By adding “/feed/” to the end of the web address of the source site to which the content is intended to be pulled, it is checked whether the new web address is available. The feed URL is used if the resulting web address is valid.
	The source site’s page source code is viewed whether feed url is in the source. The feed is used as the URL if there is a web address found in the page source when searched for “RSS”, “Atom” or “Feed” (Control + F, or Command + F on a Mac).
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The steps you should take to start using Octolooks Scrapes immediately after your purchase are pretty straightforward. Let us examine all the details of this process together.

Octolooks Account

To view the details of your current orders, complete your pending orders or access the required installation files and your purchase codes later, you need an Octolooks account that you can sign in when you need.

Your account; is automatically created when you complete the “Billing details” form on the payment page and proceed to the payment step, and your login information will be forwarded to your email address with the title of “Your Octolooks account has been created!”, so you don’t need to create an account manually. You can edit this information later on your account details page as you wish.

Since the login information of your account is automatically sent to the email address you specified, it is recommended that you check your information and verify its accuracy. Even you are sure about your information, but the email does not reach your inbox, please check your spam / junk folder or contact us.

Setup file and purchase code

In order to install and validate Scrapes on your website, you need the WordPress plugin file and the purchase code (license key). Although your account is set up when you have completed billing details form and move to the payment step, your access to the installation file and purchase code is only provided when you successfully complete the payment process.

Immediately after the successful payment, you will be directed to an information page with order details. You can download the installation file “Scrapes.zip” from the section named “Downloads” on this page and access your purchase codes from the section named “License Keys”.

You can access this information later by clicking the “View” button from the orders page on your account or by viewing the email titled “Your Octolooks order is now complete” sent to your email address. Once you have received your installation file and purchase code, you can proceed to the installation step.

Installation

The first step to start the installation is to upload the required installation file to your website. The installation file is named “ol_scrapes.zip” under “Plugin” folder located in the “Scrapes.zip” file that you downloaded, so be sure to not upload the downloaded file directly without extracting instead of the installation zip file only. The instructions you should follow are no different from those of other WordPress plugins, as described below.

	Sign in to the WordPress administration (wp-admin) panel.
	Click the “Plugins » Add New” link from the left navigation.
	Click the “Upload Plugin” button at the top left of the screen
	Click the “Choose File” button and select “ol_scrapes.zip” file.
	Click the “Install Now” button to start the upload process.
	Click the “Activate Plugin” button after upload process is completed.
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Immediately after the installation, the Scrapes menu is added to the left navigation in your WordPress administration panel. This means that you have successfully completed the setup process.

Purchase code validation

The final step is the purchase code (license key) validation to start using Scrapes. The steps you should take to do this are as follows.

	Sign in to the WordPress administration (wp-admin) panel.
	Click the “Scrapes » Settings” link from the left navigation.
	Enter the purchase code and domain field values completely and accurately.
	Check the terms of use conditions beginning with “I confirm”.
	Click the “Save” button which turns active state.
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“Purchase code is validated” message is displayed immediately after the validation process. This means that you have successfully completed the validation process. Other details you need to pay attention to when performing the validation process are as follows.

	The address of the website you are installing and the address entered in the domain field must be the same.
	Your purchase code is defined to the first validated domain, and only works for this domain including its sub domains of this domain and localhost.
	In order to run on SSL certified domains, you must type your domain name in “http” instead of “http(s)”. So it works smoothly in both cases.
	If you didn’t decide your domain name yet, you can register it with “http://localhost” domain name to run the plugin on localhost for testing purposes and contact us for change after you decide your domain name.


Deactivation and deletion

In order to deactivate the plugin log in to your WordPress administration panel and click “Plugins » Installed Plugins” link from left navigation. Afterwards click “Deactivate” link under Octolooks Scrapes plugin. You will see Scrapes tab with Octolooks logo is disappeared when the deactivation process completed. You can also click “Delete” link and completely remove the plugin from your server.

Update

If you don’t have any currently running Scrapes tasks, deleting the old version and installing the newer version of the plugin is enough to update. But if you already have Scrapes tasks and want to preserve them, you should follow these steps below for a smooth update process.

	Backup your existing tasks from “Tools » Export” menu, select “Scrapes” option and click “Download Export File” button.
	Deactivate “Octolooks Scrapes” from “Plugins” menu, and then delete.
	From “Plugins » Add New” menu, click “Upload Plugin” button and upload the new zip file. Then complete the installation by clicking “Install Now” button.
	From “Tools » Import” menu, click “WordPress » Run Importer” link. If you don’t have WordPress importer tool, you can install it from the same menu by clicking “Install Now” link.
	Click “Choose File” button and select your backup xml file, then complete the process by clicking “Upload file” and import button.
	Your old tasks will be on “Scrapes » All Scrapes” menu with the status “Waiting”. In order to run them click “Edit” button, check for the new fields that may appear for newer version and choose your options then finally click the “Save” button to save changes you made.


We have assembled the issues that you may encounter in some situations when you use Scrapes, and the steps you need to follow to easily resolve these issues.

Table of contents


	Gives “The package could not be installed. No valid plugins were found” error during installation.
	Gives “Failed to open stream: No such file or directory” error after installation.
	Gives “An error occurred while connecting to server.” error while activating.
	Gives “Domain name is not matching with your site.” error while activating.
	Gives “Purchase code is not approved.” while activating.
	Gives “Purchase code is already exists.” error while activating.
	The visual selector is not opening at all.
	The visual selector shows a blank (white) screen.
	The visual selector gives “A valid URL was not provided” error.
	The visual selector gives “cURL” error.
	The website in the visual selector is different or missing elements from the normal website.
	The website in the visual selector shows CAPTCHA (I’m not robot).
	Gives “403” or “404” error while creating a task.
	Task status is stuck at “Preparing”.
	Task status is “Running” but no new post is created.
	The images in the post content are not showing.
	Downloading images even not checked “Download images to media library” option.
	Translate is not working.
	Tracking log file.


Gives “The package could not be installed. No valid plugins were found” error during installation.

The installation file is the file named “ol_scrapes.zip” located in “Plugin” folder in “Scrapes.zip” package zip file. In order to install the plugin, if you upload the downloaded file directly instead of the installation file, you see this error message. You can reach out detailed information about installation steps in our related blog post.

Gives “Failed to open stream: No such file or directory” error after installation.

Some antivirus software installed automatically by hosting providers may mark our “shell commands” included in our plugin which provides pinging for automatic task start in main plugin file “class-ol-scrapes.php” harmful and may cause this error because of renaming this file or changing the extension. In order to solve this issue you can learn which lines are marked harmful from this antivirus software by asking your hosting provider first and contact us with this information.

Gives “An error occurred while connecting to server.” error while activating.

Some firewall software installed by hosting providers may give this error message because of blocking outgoing connection requests on your server. This blocking rules must be removed in order to ensure that your purchase code is validated during activation, as well as to send requests to the target sites to be scraped. In order to resolve this issue, you can contact your hosting provider to request not to block your outgoing connection requests on your server.

Gives “Domain name is not matching with your site.” error while activating.

You encounter this error message if the domain name of your website and the domain name value that you defined in “Domain” field in the settings screen are not the same. In order to resolve this issue install the plugin to the website you want to use; in the settings page instead of defining another domain name you can define the same domain name of the website you are installing on.

Gives “Purchase code is not approved.” while activating.

You encounter this error message if the code you define in “Code” field does not match the purchase code (license key) on the plugin’s settings page. In order to resolve this issue you can verify and check the accuracy of the code you defined. You can reach out detailed information about accessing license keys steps in our related blog post.

Gives “Purchase code is already exists.” error while activating.

You see this error message if your purchase code you are trying to define on the settings screen of plugin is defined or active on the domain name of a website you used previously. In order to resolve this issue and reset your domain registration, you can contact us after deleting your purchase code from the settings page. You can reach out detailed information about purchase code activation steps in our related blog post.

The visual selector is not opening at all

You may encounter this problem if some of the plugins installed on your site load CSS and Javascript codes on all other pages without limiting their pages. If the visual selector is never opened, cannot be clicked by a black shadow area, is opened in a very small size, or your web browser prints a console error, this is a clear indication of this incompatibility. In order to resolve this situation, you can temporarily disable all plugins one by one until you find the plugin that is causing the problem, and observe whether the visual selector is working. When creating a new task, you can disable the plug-in which causes the problem to enable it later, or you can contact the developer of this extension.

The visual selector shows a blank (white) screen.

You may encounter this problem if some source sites block the IP address of your server to prevent excessive requests from your server. In order to resolve this issue you can stop all tasks that retrieves content from the relevant source site. Wait for a while (it may take up to 24 hours for some website) then create only one task to reduce the number of requests sent by increasing the value of “Wait next processes” to 5-10 seconds.

It is more common that you often encounter this problem with popular shared hosting services because of possible requests from other sites with the same IP address where you share the server. In order to resolve this issue, you can define a proxy as described below in your WordPress configuration file (wp-config.php) located in the parent directory to change the IP address used in the requests to the source site.


	
		/* Configure HTTP Proxy Server */

		define('WP_PROXY_HOST', '192.168.1.1');

		define('WP_PROXY_PORT', '3128');

		define('WP_PROXY_USERNAME', '');

		define('WP_PROXY_PASSWORD', '');

		define('WP_PROXY_BYPASS_HOSTS', 'localhost');
	


If the proxy you are using does not require a user name and password, you do not need to add the corresponding lines. You can find out your premium or free proxy is running by creating a new task with https://www.whatismyip.com defined in “Source URL” field and checking the IP address in the visual selector. The IP address you see in the visual selector must be the same in your wp-config.php value.

The visual selector gives “A valid URL was not provided” error.

If you do not define a valid web address in the “Source URL” field or if you try to define other fields with a visual selector without selecting “Post item” while editing the “Serial” type task that you created, you encounter this error message. In order to resolve this issue when creating a new task you can define a valid web address in the “Source URL” field. While editing a previously created task, you can redefine the “Post item” field with a visual selector before you can define other fields with the visual selector.

The visual selector gives “cURL” error.

You may encounter these and similar error messages due to “Network”, “DNS” or “Firewall” problems caused by some hosting services. In order to resolve this situation, you can contact your system administrator or hosting service provider directly using the message template below.

“Hello, I am using a WordPress plugin to retrieve data from (Enter target site here) and getting cURL Error (Enter full error here). Can you please check and help me to solve if it is netword related? Thank you very much in advance, your support is greatly appreciated”

The website in the visual selector is different or missing elements from the normal website.

Due to the Cross-Origin (CORS) policy implemented by web browsers for security purposes; If you try to pull content from an SSL-certified (Secure, https) website without SSL certificate (Not secure, http), you encounter this problem because files such as CSS, font and image cannot be uploaded to the visual selector (Your admin panel is https, target website url is http). In order to resolve this issue, you can edit relevant URLs, or temporarily disable and enable your SSL certificate, so that your site and the target site have the same protocol.

The website in the visual selector shows CAPTCHA (I’m not robot).

You may encounter this problem if some resource sites detect that excessive requests from your server are automatically performed in a specified period. Since CAPTCHAs are mostly JavaScript-based and cannot be solved on the server side as described in our related article, you can try to apply the solutions specified in “Visual selector shows blank (white) screen” to resolve this issue.

Another possible solution you can try to define cookie values to be sent to the source site in the task after opening the resource site in your own web browser and encounter the related CAPTCHA and resolve.

Gives “403” or “404” error while creating a task.

You may encounter these error messages from “Apache security module” filters installed by some hosting services if these filters identify variables such as “concat”, “contains” in the XPath codes defined by the visual selector. In order to resolve this issue you can follow these steps below

	You can deactivate the corresponding module installed in your hosting service for a while, or contact your hosting service provider to do so. After successfully creating the task, you can re-enable this module.
	Click on the “Settings » Permalinks” link in the left navigation and without making any changes in the opened settings screen, you can click the “Save Changes” button and observe the results.
	
You can observe the results by adding the following code to the “.htaccess” files in the main directory of the server where your website is installed and in the “wp-admin” folder if any.

		
			<IfModule mod_security.c>

			SecRuleEngine Off

			SecFilterInheritance Off

			SecFilterEngine Off

			SecFilterScanPOST Off

			SecRuleRemoveById 300015 3000016 3000017

			</IfModule>
		
	



Task status is stuck at “Preparing”.

You encounter this problem if the WordPress cron (wp-cron.php) mechanism, which allows the task to start automatically when the specified runtime arrives, is not triggered as it should. In order to resolve this issue you can apply the following solution suggestions.

	
You can use the WP Crontrol plugin to detect the problem found in your WordPress cron mechanism. Once you have activated this free, third-party WordPress plugin click on “Tools » Cron Events” link to share the error message if any on the opening page with your hosting provider or system administrator by using the template message below.

“Hello, my wp-cron.php file is not pinged and I’m getting an error message (Enter full error here) on my WordPress administration panel. Can you please check and help me to solve it? Thank you very much in advance, your support is greatly appreciated”


	DNS settings or firewall blocking rules identified by some hosting services can cause this problem. In order to resolve this issue, you can define your server’s IP address and domain name in the “hosts” file if you have access, or you can contact your system administrator or hosting service provider to do so.
	Having basic authentication or maintenance plugin installed on your WordPress site causes your cron file not to be pinged and makes it out of reach makes you encounter this problem. In order to resolve this issue, you can disable the relevant plugins to make the cron file accessible from the outside.
	
In order to enable alternative WordPress cron, you can observe the results by adding adding the below code line; before “That’s all, stop editing! Happy blogging.” expression in “wp-config.php” file which is located in the main folder of your WordPress installed site.

		
			define('ALTERNATE_WP_CRON', true);
		
	

	
Although you have checked the “System” option for the “Cron type” field, you may encounter this problem because of the restrictions that shared hosting services impose on the shell commands that are executed from the PHP files. In order to resolve this situation you can manually add the following line to your crontab by running the command “crontab –e” via the shell connection or server management panel like cPanel.

		
			* * * * curl http://(Your URL here)/wp-cron.php > /dev/null 2>&1
		
	

	In case of your cron file is not triggered properly or the steps you follow to trigger are inconclusive you can use third party remote pinging services like EasyCron in order to ping your http://(Your URL here)/wp-cron.php file instead of local pinging.
	You encounter this problem if your WordPress installed website server’s timezone or automatic date/time update settings are corrupted. After you register the task, in order to resolve this situation, you can update your server’s system time after you confirm that “Next run” value is not the same as the minute value of the hour you are recording, or 1 minute forward. You can contact your system administrator or hosting service provider to perform this system timezone update operation.
	You may encounter this problem because some plugins that are installed on your WordPress site or that have previously used the automatic processing, use the WordPress cron queue heavily that Scrapes cron events are not processed from this queue. In order to resolve this, you can disable other plugins that perform automatic processing, and you can remove other tasks that occupy the cron with the WP Crontrol plugin described in section 1.
	If you migrate your WordPress site from database dump to a different domain name, you encounter this problem. In order to resolve this, after you remove the license information that was automatically installed on your new WordPress site with database dump on settings page, so you can contact us to change your domain name registration to your license code.


Another possibility is that, your plugin files may be corrupted while uploading for some reason if you do not see your changes after a task save you can confirm this situation. In order to resolve this issue please follow the steps below.

	Remove your purchase code from the “Settings” screen.
	Delete the “ol_scrapes” plugin folder under “wp-content/plugins” from your server with your FTP client.
	Download the latest version from  with your account.
	Upload the “ol_scrapes” plugin folder to “wp-content/plugins” after you unzip “ol_scrapes.zip” file.
	Login to your WordPress admin panel and check the result.


Task status is “Running” but no new post is created.

The creation of a new post may take up to 10-15 seconds depending on the content in the source site and the intensity of the settings defined when creating the task. In case of no change in the value of “Last scrape” for more than 10 minutes despite the task operation start, you can apply the following solution suggestions.

	If the XPath value defined in the “Post item” field with the visual selector does not match the XPath value for the links that are located on the listing page of the source site and referencing to the detail page when they are clicked, you encounter this problem. In order to solve this situation with “reference a element not found” error message logged and to define the manual XPath with exacth match option in the task, you can contact us after making sure that this error message is found in your log file and sharing us the source url.
	
You encounter this problem because of the limits imposed by some hosting services and limiting the maximum execution time required for the task to run. In order to resolve this issue, which is saved in the log file as “single scrape started” and then the sudden stop of the log recording in the middle of task run, you can check your log file and make sure that this happens. Then you can contact your system administrator or hosting service provider directly using the following message template.

“Hello, I am using a PHP script which needs to run 5 minutes without a break. Can you please set my max_execution_time directive in a php.ini file to “0” (Unlimited) or to “300” (5 minutes) at least? Thank you very much in advance, your support is greatly appreciated”


	You may encounter this problem if some resource sites block the IP address of your server to prevent excessive requests from your server. In order to solve this issue, you can try to apply the solutions specified in “Visual selector displays blank (white) screen” section.
	
You encounter this problem if the defined “Run frequency” value is less than the minimum time required to scrape the contents of the source site. When the time elapsed since the start of the task has reached the defined value in the “Run frequency” field, new posts will not be created since the task will stop and start again from the beginning even if the contents of the source site are not all grabbed. In order to resolve this issue, epsecially when there is a large number of content available on the resource site, and if “Unlimited” is selected for the “Total posts” field; Instead of defining a short value such as “Every 5 minutes” in “Run frequency” field. You can define a reasonable value enough to scrape all content from the source site such as “Every day”.

The value defined in the “Total posts” field represents the initial posts on the listing page of the source site; the perception that a total posts amount of new post will be created during each task is not true.




The images in the post content are not showing.

You encounter this isssue in the situtaion that some source sites, in order to increase the page opening speeds instead of identifying the “img” tags with the “src” attributes of their contents directly, they can use the so-called lazy load JavaScript method to load the page images while hovering from and identify “data-src” or “data-lazy-src” attributes. In order to resolve this issue where 1 pixel transparent “placeholder” image is mostly defined “src” attributes instead of real image is downloaded, you can add ” Find and replace “rule below to the task’s content area. If the source site uses another HTML attribute instead of “data-lazy-src ” or the defined custom attribute is before src attribute, the regex code defined in “Find” field must be updated with the same attribute name or change order.


	Find: \ssrc="([^"]+)(?:.*?)data-lazy-src="([^"]+)"

	Replace: src="$2"


Downloading images even not checked “Download images to media library” option.

Although you do not want to download the images contained in the source site to your own server, you do not select the “Download images to media library” option in the task’s content area, but you encounter this problem if you make any definition to the featured image field. You can use Featured Image from URL plugin to resolve this issue, which is caused by the fact that the featured images must be from the media library on your own WordPress site by default, as opposed to images that can be viewed remotely without downloading to your own server.

By enabling this plugin, which is a free third-party WordPress plugin, you can have the XPath value of the image displayed without identifying it in the featured image field (if it is automatically defined please delete it), and downloading. Instead defining a “Custom field” with the settings below to not download and show remotely. You can edit this setting, which is generally automatically found on most sources featured image, to match the image you want.


	Name: fifu_image_url

	Value: //meta[@property="og:image"]

	Attribute: content


Translate is not working.

You may encounter this problem if the service providing the translation service blocks the IP address of your server to prevent any excessive requests. Since translation service is provided free of charge through the unofficial API normally provided by “Google Translate”, a paid service, you can try to apply the solutions specified in “The visual selector shows a blank (white) screen” section to resolve this situation. Also you can search for “Google translate service http error” in your logs to make sure that you are making excessive requests.

Tracking log file.

Each task records the operations it performs with its identifier number (ID) in the file “logs.txt” under the “/wp-content/plugins/ol_scrapes/logs” folder. You can open and review this recording file with any text editing tool to see the step-by-step process of the plugin’s task, or to quickly detect a possible problem you may encounter.

The server system time, task identifier number (Scrapes Task ID), process identifier number (PHP process ID) and the current RAM usage information are saved as a new line in the log file for each operation. You can examine the logs from the related tasks by searching. “TASK ID: (Enter task ID Found on dashboard)”. Other keywords and their descriptions you can search are as follows.

	“Number of posts” indicates how many posts have been processed in total.
	“Number of links” shows how many redirecting detail page links are found on the listing page.
	If there is a defined “Find and replace rule” in the task “Before regex” and “After regex” indicates the content before and after processing.
	“Post updated”and “Post inserted” indicates that the post has been updated or added when “Update post” option is active.
	“Repeat count” indicates the number of times that the source site has been re-encountered same content with previously captured content.


We listen to your feedback and implement frequently requested features to keep our products always new, updated and stable with the most innovative solutions.

Changelog

2.3.0Latest and stable19.07.2023

	New feature – Amazon, Lingvanex, and DeepL free translation services
	New feature – Multiple keys for translation services
	New feature – Apify integration for JavaScript-rendered websites
	New feature – ChatGPT support
	Improvement – WordPress cron management.
	Improvement – YouTube RSS support.
	Improvement – Query performance on the dashboard.
	Improvement – PHP 8.x and WordPress 6.x compatibility.


2.1.017.06.2020

	New feature – Bing Microsoft Translator
	New feature – DeepL Translator
	New feature – Google Translate (Official)
	New feature – Yandex Translate
	Improvement – Minor code fixes.


2.0.102.08.2019

	Improvement – Fix for translation feature.


2.0.030.11.2018

	New feature – Filters
	New feature – Next page finding with parameters
	New feature – Spinner integration
	New feature – Initial task start time determination
	Improvement – UI improvements.
	Improvement – Minor code fixes.


1.4.403.08.2018

	Improvement – Fix for translation feature.


1.4.323.10.2017

	Improvement – Minor code fixes.


1.4.223.09.2017

	Improvement – Better performance on shared servers with low execution time.
	Improvement – UI improvements.
	Improvement – Minor code fixes.


1.4.115.06.2017

	New feature – Exact match option while selecting post items (Thanks to htcam)
	Improvement – Minor code fixes.


1.4.009.06.2017

	New feature – Content language translation
	New feature – HTML Tag support for custom fields (Multiple content selection)
	New feature – Custom fields can get other custom field value in templates
	Improvement – Minor code fixes.


1.3.217.02.2017

	New feature – Localization ready.
	New feature – Find and replace option with regex for date field.
	New feature – Embed support for Facebook.
	Improvement – Minor code fixes.


1.3.106.02.2017

	New feature – Automatic featured image finder algorithm.
	New feature – Automatic required cookies definer for Twitter.
	New feature – Automatic required cookies definer for Facebook.
	New feature – Automatic content XPath definer for Facebook.
	New feature – Automatic Amazon Affiliate product template tag for custom fields.
	New feature – Automatic Amazon Affiliate cart template tag for custom fields.
	New feature – Embed template tag for content.
	Improvement – Minor code fixes.


1.3.027.01.2017

	New feature – Visual selector option for feed (RSS & Atom) task type.
	New feature – Mathematical calculations option for custom fields.
	New feature – Amazon ASIN template tag for custom fields.
	New feature – Run type option for serial task type.
	Improvement – Minor code fixes.


1.2.011.01.2017

	New feature – Live status information and actions for all scrapes screen.
	New feature – Template option for title and excerpt fields.
	New feature – Find and replace option with regex for fields.
	Improvement – Minor code fixes.
	Improvement – UX & UI improvements.
	Improvement – Better algorithm for XPath selector.
	Improvement – Better support for pages with non UTF-8 charset.


1.1.012.12.2016

	New Feature – Cookies.
	New Feature – Automatic completion and suggestions for custom fields.
	New Feature – HTML element attribute scraping option for custom fields.
	New Feature – Template option for custom fields.
	Improvement – Minor code fixes.
	Improvement – UX & UI improvements.
	Improvement – Better integration with WooCommerce.


1.0.130.11.2016

	Improvement – Minor code fixes.


1.0.023.11.2016

	Octolooks Scrapes released.


In this article, we are talking about the proxies, process of scraping and how exactly it can help affiliate marketers.

Affiliate marketing might seem to be a new concept, but in reality, it’s not. It’s quite an old practice to get a kickback for bringing someone a client. The only nuance that changed is the approach to the process. In the past affiliate marketers had to walk around sticking ads on walls and advertising the goods to the target audience face-to-face. Of course, people still practice such methods to drive sales, but technologies brought us more opportunities to reach more potential customers with a single message.

Today you can simply share an affiliate link to the product in the blog, or on your social media platform. And if someone uses this link to make a purchase, you get a reward for bringing the customer. So now instead of placing ads on walls affiliate marketers write reviews and post them on the Internet, for example.

This practice is appealing for both sellers and affiliate marketers. While the latter receive money for their work, sellers increase their revenue without investing a lot of funds and time in marketing campaigns. Therefore, it’s quite easy to find businesses that offer affiliate programs. And the advertising job became simpler for marketers as well thanks to all the tools like ours that can speed up and ease processes.

Our Automatic WordPress Scraper and Content Crawler Plugin Scrapes can bring you valuable data very quickly and in large quantities. In this article, we’re talking about the process of scraping itself to understand this instrument better. And, of course, we are going to tell you how exactly this tool can help affiliate marketers.

What is web scraping?

It’s a process of gathering available data from the Internet. It’s a very time-consuming and, most importantly, extremely boring job for humans. However, computers are great at gathering and analyzing lots of information. So it’s only logical to let them take responsibility of this process and sit back while the data you want to gather is getting acquired.

To gather information you will require a web scraper – a special program, a robot if you will, that is created to crawl through websites, acquire the needed information, and process it. Using this tools, you will only need to set the requirement for the data. The scraper will gather, organize and present it to you in the easy to consume format.

Is scraping legal?

Yes, until you are gathering the information that is available for the public eye. There are no strict legal regulations when it comes to web scraping. So while you’re not violating anyone’s privacy or rights, you’re not doing anything wrong. Basically, a scraper does exactly what you would do to gather data – browses the pages and processes the information published on them. The only difference is that the robot can do this job much more efficiently and quicker than you. Please check “Is it legal to use?” title on our F.A.Q section for more.

What are the pitfalls?

A lot of website owners are not very fond of web scrapers. These robots may gather information for competitors of a business – that’s one of the reasons why e-commerce sites usually try to keep scraper bots away from their servers. They would implement various anti-scraping techniques. The most widely-used method is to block the IP address that sends the peculiar number of requests.

Also, if scraping is not executed properly, it looks like a DDOS attack. To gather the information a bot goes to the web page which means it sends the destination server a request. If there are too many of these requests, and they all come from one IP address – it looks like a hacker attack to the destination server. So it blocks the IP and doesn’t accept any more requests coming from it.

Both of these issues can be solved with two actions. The first thing you should do is to lower the number of requests the scraper sends. The bot should send them with at least a small pause – say, a couple of seconds between requests. Then your scraping activity will seem more natural to the destination server. Increasing the value of “Wait next processes” option may help in this case.

Another and more effective solution that should be implemented along with reducing the number of requests is proxies. A proxy is a remote server you can use as a medium between your device and the destination server. As you connect to a proxy server, you pick up its IP address and use it to mask your authentic data. Therefore, when you reach the website, the destination server can’t see your real IP. This means you can pretend to be different people if you use proxies.

You can find free proxies, but we advise against using them because they’re not reliable. You don’t know who else is using them, and most of such IP addresses are already blacklisted. Thus, free proxies can do more harm than good if you use them for scraping – you will constantly get blocked, and the process will get stuck.

You should look for reliable providers that offer quality proxies for affordable prices. A good example of such a provider is  Infatica. This vendor offers three kinds of proxies – datacenter, residential, and mobile. The best choice is residential proxies, and here is why.

Datacenter proxies are shared servers used by several customers simultaneously. While this solution is still quite reliable, datacenter proxies might increase your risk of getting blocked. Residential ones, on the other hand, are real devices that use IP addresses issued by an ISP. And you are the only user connected to a residential proxy at the same time. Therefore, the destination server won’t even suspect that the request is sent by someone who is using proxies. Mobile type is quite the same as residential with the only difference – these are IPs of just mobile devices. Such proxies are quite expensive, and they’re too much for scraping.

So, if you use residential proxies and keep your scraper at a reasonable pace, you can expect the data gathering to be quite effective. Of course; there are some more anti-scraping measures that you can’t bypass with only proxies but once you decide to get a proxy service from this provider, you can easily define the required lines in your wp-config.php file as it described on our related post.

How to use web scraping to boost affiliate marketing?

You can utilize this approach to gather valuable data for your activity. So let’s see in detail how exactly Octolooks Scrapes will help you improve the processes and boost your income.

Search for the sites with affiliate programs in your location

It’s rather cumbersome to gather all the websites of e-commerce business in your country, let alone structuring the list by sectors and other criteria. You will waste a lot of time and effort trying to complete this job manually. Moreover, the chances that you create an incomplete list are quite high. So it’s more logical to trust a robot this job and let it gather all the relevant websites for you. Then you will have a complete list to jumpstart your affiliate marketing activity.

Get the list of relevant products to offer them to your users

Using different parsers you can build a custom scraper and implement it on your website. Such a bot can bring the list of positions from your partners considering the keywords users are searching for. Also, if the e-commerce website you’re working with has a very wide choice of goods, you can use such a scraper to fish out goods that will be useful for your customers.

Define the best selling goods to drive sales

Using scraping you can analyze the websites of your partner’s competitors to determine the most popular positions. Advertising bestseller products you can increase your income as more users will buy these goods. Also, you can see which positions have higher commissions, and stick to those to get more money.

Keep the data updated

There is nothing worse for your business than the user clicking on the affiliate link and seeing that the product is out of stock, or the price is different. Such a potential buyer will leave both your and your partner’s websites increasing the bounce rate and lowering your SEO qualities. Also, chances are very high this user will never come back to you, especially if it’s not the first time you provide them with false information.

Octolook Scrapes’ “Update post” feature will help you keep the data updated to offer your clients relevant and real information. This will help you gain trust and, therefore, more users will get attracted to your WordPress based website.

Gather customer reviews

You can use them to make your own reviews and advise your audience about certain goods. Or you could place the gathered testimonials on your site tos to prove the trustworthiness of the data you offer. This is a nice move that will help you sell more positions and, consequently, increase your income and gain trust.

Get the leads

Octolooks Scrapes can help you gather emails, social media posts, and other contact information that you can later use to send offers to your target audience. Also, this can help you learn your customers better as you can go through their interests, locations, jobs, and other valuable data. Then you can figure out which content will have a higher conversion rate considering the details about your target audience.

Bottom line

Affiliate marketers come up with different uses for web scraping, and we have listed the most widely-used practices in this article. We hope, this information will help you increase your income and, perhaps, inspire you to come up with your own implementation of scraping. If you have experience of using Octolooks Scrapes for affiliate marketing, we will be glad to hear about it.

You’re a small business owner. You can’t afford the negative publicity surrounding a big data breach like Adobe, eBay, or LinkedIn. And the last thing you want is for some hacker to log in to your site and wreak havoc on your marketing plan. But how are you supposed to secure a website if you don’t have an IT degree?

Why is Web Security So Important?

Before you understand ‘how,’ it’s important to know ‘why.’ Your website is a crucial component of your online presence. If you get hacked, this can cause a reputation crisis that leaves your customers and clients with little faith in your ability to secure their data. Even more alarming, according to WebARX, your site may be at risk of being blacklisted if it is targeted and subsequently infected with malware or a virus. This can cause a sudden drop in traffic, which equals a drop in revenue.

Pros That Can Help

Fortunately, you do not have to be an information technology expert to secure your site. There are plenty of people out there who can help. If it’s in your budget, start by hiring a webmaster. This is an individual that may develop and monitor your website, and they can implement strategies to keep your data safe.

If you can’t afford a dedicated tech guru, look for a freelancer with experience in cybersecurity. As with all professionals, no two cybersecurity experts are alike. Each will have a different set of experiences, and you can find the right fit by reading reviews from people who have hired them in the past. A freelancer will be more affordable than a dedicated worker, and you can easily find a new service provider if they are unable to affordably secure your website when you need it.

Tips To Protect Your WordPress Site

If you are still considering handling your own website security, there are a few things you can do to keep yourself safe. These include:

	Limiting user login attempts. Limiting both user and administrator login attempts is a great way to keep your WP site safe. To do this, you can install a plug-in that prevents both human and automated spam bots from trying multiple passwords to access your information.
	Adding multi-factor authentication. Multi-factor authentication means that you use two or more steps to log in to your site. For example, you will need a password and then a PIN, which will be automatically sent to you from the site to the email address you have on record.
	Reducing access to essential employees. Only essential employees should have access to your WordPress Admin Dashboard. This reduces the number of people with access to the ability to change your website. A good rule of thumb is that only managers and your IT staff can access your digital data.
	Logout idle users. Idle users are people who have logged into your website but have walked away or changed tabs. Unfortunately, this poses a significant security risk, particularly when you have users that access your site from a public place, such as a library, or are using an unsecured network. As with most things on WordPress, there are multiple plug-ins that will help you log these users out after a period of no activity.


Having a secure website is one of the best things you can do for your business. Before you get started, do your research. Know what areas you need to secure and who can help you do it. Ultimately, your goal is to ensure that your and your users’ information is safe and uncompromised. How you make this happen depends on your site, but the tips above, including limiting user login attempts and reducing the number of people with access to your dashboard, can get you started.

And remember, you can automatically post your content with WordPress Scraper Plugin, instead of giving editors that you do not know the authority to post to your site.

As a business owner, you rely on marketing and sales to drive business growth and boost your bottom line. If you can’t find the experts you need in your immediate vicinity — or don’t need them full-time — you might decide to search outside of your company for the expertise you need. This also allows you to look further afield, opening up the possibility of remote work. Highfive explains that hiring remotely can save you money and make it easier to access top talent. This guide explains how you can find, hire, and manage external sales and marketing professionals to help you reach your business goals.

Set up a formal business entity to simplify remote hiring.

Whether you plan to hire external workers as employees or on a freelance basis, you need a business structure in place so you can legally enlist their services. A limited liability company (LLC) is one option. It’s easy to set up, has simple tax and reporting requirements, and protects your personal assets in case of business liability issues. Check your state’s regulations for LLC formation to get started. You can then use a business formation provider like Zen Business start up services to get the paperwork done quickly and affordably.

Define your sales and marketing goals.

To figure out what kind of sales and marketing pros you need to hire, first identify your goals. Define concrete objectives using KPIs, key performance indicators. Klipfolio explains that KPIs offer a measurable means of checking how well you’re meeting business objectives. A sales KPI might consist of X units sold in a set time period, for example. What type of professional will help you meet this end goal and what skills should they possess?

Write detailed job postings and vet applicants to choose the right people.

By identifying the skills you need in your team to meet your sales or marketing goals, you can write a detailed job posting. For example, you might decide that you want to boost your business’ content marketing. According to SEMrush, skills to look for in a content marketer include social media, SEO, and strategy abilities. You’ll want to include these points in your job ad. As you review applicants, read their resumes to check that they have these skills. You can then use video interviews to vet promising applicants more closely. Workable explains that video interviews tend to result in higher quality hires and has a guide for employers on how to conduct informative interviews.

Figure out what tools your remote team needs to get the job done.

Once you’ve found the sales and marketing professionals you need, find ways to facilitate their success. Nimble offers a list of project management tools that can help virtual teams collaborate, like Asana and Trello. Also, consider off-the-shelf services to support your business, including hardware and software solutions like the Microsoft suite or antivirus software. Such solutions can also support individual departments. For example, a WordPress scraper like Scrapes can help drive better content marketing results. This product is from Octolooks, which provides many other professional solutions — most of them WordPress-based — designed to empower businesses.

Set up a regular communication network to monitor progress.

While hiring remote sales and marketing professionals has advantages, it also poses some challenges. WFMDepot explains that communication is a key hurdle faced by remote teams. Towards this end, proactively implement collaboration tools to keep everybody up-to-date on projects, timetables, and deadlines. Inside Design recommends Slack as the best communication tool for quick checking in. With this tool, you can chat with your team in real-time from afar.

Sales and marketing are the cornerstones of your business success. Don’t skimp when it comes to hiring talent in these fields. With remote work, you have access to a greater pool of professionals than ever before. Make the most of it by following the above tips.

The right technology will facilitate your remote team’s work. Octolooks provides a variety of business solutions that can help your sales and marketing teams thrive. Find out more.
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